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REZIME:

Rad se fokusira na analizu mogucénosti primene QGIS softvera za obradu podataka o putno-pruznim prelazima (PPP)
na primeru pruga u Srbiji, koji predstavljaju klju¢ne tacke interakcije izmedu drumskog i Zeleznickog saobracaja sa
znacajnim rizikom od nesreca. Baze podataka o vanrednim dogadajima vode se preko eksel tabela putnih prelaza
na prugama u Srbiji i tabela evidentiranih nesreca i nezgoda. QGIS sistem je predstavljen preko uvodnih razmatranja
i istorijata, a zatim je predstavljena najnovija verzija sa mogu¢nostima primene uopste i posebno u Zeleznickom
saobracaju. Obrada podataka kori$¢enjem QGIS sistema prikazana je kroz nacine kreiranja novog projekta u QGIS-u i
graficki korisnicki interfejs QGIS-a. Dati su procesi kreiranja Sloja (Layer) i ubacivanja Mape, kreiranja sloja i ubacivanja
pruga i PPP, unosa geografskih tacaka putem koordinata i putem koda. Znacajno mesto zauzima vizualizacija i analiza
podataka, kao i moguc¢nost prikaza podataka putem HTML map tips -a u QGIS-u. Implementacija QGIS softvera u radu
obuhvatila je prikaz PPP i analizu koncentracije u Srbiji. KoriS¢enjem baze podataka o PPP i nesre¢ama u periodu od
pet godina identifikovane su zona sa najve¢im brojem PPP, bezbednosni aspekati najopterecenijih pruga i izvrSena je
prostorna analiza cele Zeleznicke mreZe.

Kljuéne reci: QGIS, Zeleznica, putno-pruzni prelazi, nesrece, baze podataka

SUMMARY:

The paper focuses on the analysis of the possibility of applying QGIS software for processing data on road-railway
crossings on the example of railways in Serbia, which represent key points of interaction between road and rail traffic
with a significant risk of accidents. Databases on extraordinary events are maintained through Excel tables of road
crossings on railways in Serbia and tables of recorded accidents and incidents. The QGIS system is presented through
introductory considerations and history, and then the latest version is presented with the possibilities of application in
general and in railway traffic in particular. Data processing using the QGIS system is shown through the ways of creating
anew project in QGIS and the graphical user interface of QGIS. The processes of creating a layer and inserting a map,
creating a layer and inserting tracks and road-railway crossings, entering geographic points via coordinates and via
code are given. A significant place is occupied by data visualization and analysis, as well as the ability to display data
via HTML map tips in QGIS. The implementation of the QGIS software in the work included the display of road-railway
crossings and the analysis of the highest concentrations of them in the entire territory of Serbia. By using the database
on road-railway crossings and accidents over a period of five years, the zone with the largest number of crossings, the
safety aspects of the busiest railways, and a spatial analysis of the entire railway network were identified.
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1.UVOD

Rad se bavi analizom putno-pruznih prelaza (PPP),
koji predstavljaju klju¢ne tacke interakcije izmedu
drumskog i ZelezniCkog saobracaja. Ove tacke su od
izuzetnog znacaja za bezbednost i efikasnost sao-
bracaja, jer predstavljaju kriticna mesta interakcije
dve razlicite vrste saobracaja. To su mesta na kojima
je najvedi rizik od nesreca. Analiza i unapredenje bez-
bednosti na ovim prelazima moZe znacajno dopri-
neti smanjenju broja nesreca i unapredenju ukupne
saobracajne infrastrukture. Cilj rada je da se prikaze
mogucénost primene QGIS sistema kao baze podataka
o stanju PPP na Zeleznickoj mreZi u Srbiji. Prikazan
je nacin obrade podataka koris¢enjem QGIS siste-
ma, tj. kroz nacin kreiranja novog projekta u QGIS-u
i graficki korisnicki interfejs QGIS-a. Dati su procesi
kreiranja Sloja (Layer-a) i ubacivanja Mape, kreiranja
sloja i ubacivanja pruga i PPP, unosa geografskih taca-
ka putem koordinata i putem koda. Znacajno mesto
zauzima vizualizacija i analiza podataka, kao i mo-
gucnost prikaza podataka putem HTML map tips -a u
QGIS-u. Implementacija QGIS softvera u radu obuhva-
tila je prikaz PPP i analizu koncentracije u Srbiji.

Rad se bazira na detaljnoj analizi trenutnog stanja
putno-pruznih prelaza, pregledima relevantne li-
terature i regulativa, kao i na studijama slucajeva.
Rad je organizovan u Sest poglavlja. Nakon uvod-
nih razmatranja, u drugom poglavlju razmatraju
se osnovni pojmovi u vezi sa puto-pruznim prela-
zima, naCinima osiguranja i na¢inima prijavljivan-
janesrecainezgoda. U tre¢em poglavlju prikazana
je baza podataka koris¢ena za izradu rada, kao i
obradeni karakteristi¢ni podaci o PPP koji su pri-
menjeni i implementirani u softveru QGIS.

U Cetvrtom poglavlju nalaze se osnove rada u QGIS
softveru, mogucnosti rada samog softvera, kao i
mogucénosti njegove implementacije u Zeleznici,
dok je u petom poglavlju prikazana obrada poda-
taka, primena softvera kao i vizuelni prikaz poda-
taka o PPP putem HTML-a. Na kraju su izloZena
zaklju¢na razmatranja.

2. PUTNO-PRUZNI PRELAZI

Putno-pruzni prelazi, denivelacija, signalizacija,
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odrzavanje infrastrukture, edukacija ucesnika u
saobracaju i tehnoloska reSenja klju¢ni su fakto-
ri koji obezbeduju bezbedno i efikasno obavljan-
je drumskog i Zeleznickog saobracaja. Ove mere
smanjuju rizik od nesreca i obezbeduju zastitu
ucesnika u saobracaju, osiguravaju funkcionalnost
infrastrukture i bezbednost ucesnika u saobracaju
na svim nivoima.

Putno-pruzni prelaz [1] je mesto ukrstanja
Zeleznicke pruge, koja pripada javnoj Zeleznickoj
infrastrukturi, industrijskoj Zeleznici ili industrijs-
kom kolo- seku i puta u istom nivou, koji obuhvata
i ukrstanje tih koloseka sa peSackom ili biciklisti¢-
kom stazom, u Sirini od 3 m mereno od ose kolo-
seka, ukljucujudi i prostor izmedu koloseka kada
se na putnom prelazu nalazi viSe koloseka.

Zona potrebne preglednosti je trodimenzional-
ni prostor preglednosti u kome se vrsi bezbedno
zaustavljanje drumskih vozila ispred saobracaj-
nog znaka koji oznacava mesto na kome put
prelazi preko Zeleznicke pruge na putnom prelazu.
Zona potrebne preglednosti mora biti obezbedena
uCesnicima drumskog saobracaja na svakoj tacki
puta ispred putnog prelaza, a odreduje se na os-
novu vrednosti racunske brzine drumskih vozila
i najvece dopustene brzine Zeleznickog vozila na
pruzi [1].

Mesto ukrStanja Zeleznicke pruge i puta je [1]
mesto u naseljenom ili van naseljenog podrucja
grada ili opStine, na mestu gde se presecaju osa
koloseka Zeleznicke pruge i osa kolovoza puta, u
nivou koloseka (putni prelaz) ili van nivoa kolose-
ka (denivelisanim putnim objektom), a koje je kao
takvo planirano urbanistickim ili prostornim pla-
nom lokalne samouprave (grada ili opStine).

Signalno-sigurnosni uredaj na putno-pruznom
prelazu je uredaj Zeleznicke infrastrukture koji
aktivira putnu saobracdajnu signalizaciju na put-
nom prelazu, kojom se uclesnicima u drums-
kom saobracaju neposredno najavljuje nailazak
Zeleznickih vozila i upozoravaju da kretanje prila-
gode tako da se bezuslovno moraju zaustaviti is-
pred putnog prelaza jer neposredno predstoji
prolazak Zeleznickog vozila [1].
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2.1. Nacin ukrstanja Zeleznickog i drumskog
saobracaja i mere za osiguranje bezbednosti
saobracaja na PPP

Ukrstanje zeleznicke pruge i puta, peSacke ili

biciklisticke staze vrsi se na dva nacina i to:

1. van nivoa koloseka, izgradnjom objek-
ta drumske denivelacije, odnosno putnog
podvozZnjaka ili nadvoZnjaka, peSackog ili
biciklistickog pothodnika ili nadvoZznjaka ili
pesackih pasarela;

2. u nivou koloseka, izgradnjom putnih prelaza,
sa odgovaraju¢om opremom ili uredajima za
obezbedenje saobracaja, kao i na zajednickom
Zelezni¢ko-drumskom mostu sa kolovozom
puta u nivou koloseka i po trasi koloseka.

Mere za osiguranje bezbednog saobracaja na put-
nim prelazima zavise od gustine saobracaja, pre-
glednosti Zeleznicke pruge, brzine voznje na pruzi
i putu i od mesnih uslova u skladu sa zakonom
kojim se ureduje bezbednost i interoperabilnost
Zeleznice. Saobracaj na putnim prelazima obez-
beduje se:

1. saobracéajnim znakovima na putu i zonom po-
trebne preglednosti;

2. svetlosnim saobradajnim znakovima i sao-
brac¢ajnim znakovima na putu;

3. automatskim polubranicima sa svetlosnim
saobracajnim znakovima i saobracajnim zna-
kovima na putu;

4. branicima i saobrac¢ajnim znakovima na putu;

neposrednim regulisanjem saobracaja na put-

nom prelazu i posebnim merama;

6. zaStitnim ogradama i saobra¢ajnim znakovima
ili mimoilaznicama i saobracajnim znakovima
na putnim prelazima za peSake i bicikliste.

v

Saobracajni znakovi na putu ispred putno-pruznih

prelaza su:

1. znak koji oznacava mesto na kome put prelazi
preko Zeleznicke pruge u nivou koloseka,

2. znak za ogranicenje brzine.

Na PPP prelazima opremljenim signalno-sigurnos-
nim uredajima mogu se instalirati video- kamere
za vizuelni nadzor zone putnog prelaza, Zeleznicke
imovine, zauzetosti kolovoza i izvrSenja bezbed-

nosti saobracaja, kao i nadzor svih ucesnika sao-
bracaja na putnom prelazu [1].

2.2. Obezbedenje saobracaja na PPP

Putno-pruzni prelazi mogu i moraju biti obez-

bedeni na jedan od ova tri nacina:

1. svetlosnim saobracajnim znacima i saobra-
¢ajnim znacima na putu (slika 1),

2. automatskim polubranicima sa svetlosnim
saobracajnim znacima,

3. branicima i saobracajnim znacima (slika 2).

Slika 1. Putno-pruzni prelaz u nivou bez branika ili
polubranika (greska)

Svetlosnim saobracajnim znacima i saobrac¢ajnim
znacima na putu obezbeduje se saobracaj samo na
mestu ukrstanja jednokolosecne Zeleznicke pruge
i puta. Svetlosni saobracajni znak, kada je aktivi-
ran, prema putu pokazuje crveno trepcuce svetlo
usmereno tako da je jasno vidljivo sa puta. Isprav-
nost svetlosnih saobracajnih znakova na putnom
prelazu KontroliSe se u posednutom Zeleznickom
sluzbenom mestu ili kontrolnim pruznim signali-
ma na Zeleznickoj pruzi. Svetlosnim saobrac¢ajnim
znacima mogu se dodati zvucni signali, u skladu
sa propisima kojima se ureduje saobracajna sig-
nalizacija na putevima i tehnic¢ki uslovi za signal-
no-sigurnosne uredaje, radi podsticanja paZnje i
opreznosti kod ucesnika u drumskom saobraca-
ju. Zvucni signal se daje neprekidno, sve vreme
dok svetlosni saobracajni znak pokazuje crveno
trepcuce svetlo [1].

Automatskim polubranicima sa svetlosnim sao-
bra¢ajnim znacima i saobra¢ajnim znacima na
putu, vrsi se obezbedenje saobracaja na putnim
prelazima,-ito [1]:
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1. magistralne Zelezni¢ke pruge sa drzavnim
putevima I reda, kao i Il reda sa drumskim
saobracajem na prelazu preko Zeleznicke
pruge sa prosec¢nim protokom ve¢im od 2.500
drumskih vozila;

2. magistralne i regionalne Zeleznicke pruge i
puta, ako je najveca dopusStena brzina na pruzi
vecaod 120 km/h i

3. ostalih Zeleznickih pruga sa putevima, ako
je na putu proseCan protok ve¢i od 5.000
drumskih vozila.

Slika 2.Putno-pruzni prelaz u nivou sa branicima

Branicima i saobracajnim znacima na putu vrsi se
obezbedenje saobracaja na putnom prelazu u nase-
ljenom mestu i na drugim mestima gde je to sao-
bracajno-tehnicki opravdano. Branikom se drums-
ki saobracaj zatvara preko cele Sirine puta kada
se zeleznicko vozilo priblizava putno-pruznom
prelazu. Obezbedenje saobracaja uredajima sa
branicima i saobrac¢ajnim znacima na putu vrsi se
na mestima gde je to saobracajno-tehnicki opravda-
no. Drumski saobracaj na celoj Sirini kolovoza puta
ispred koloseka, sa obe strane Zeleznicke pruge,
zatvara se branikom. Branici prema nacinu pogona
mogu da budu na elektri¢ni i na mehanicki pogon.
Prema mestu upravljanja mogu da budu oni kojima
se upravlja iz daljine i na licu mesta [1].

2.3. Prijavljivanje nesreca i nezgoda

Na puto-pruznim prelazima najc¢e$¢i uzrok po-
jave vanrednih dogadaja jeste sudar drumskog i
Zeleznickog vozila. Pri takvim situacijama oba-
vezno je da upravljac¢ zeleznicke infrastrukture i
prevoznik, bez odlaganja, telefonom prijave nes-
recu i nezgodu Centru za istrazivanje nesreca
u saobracaju (CINS) i republickom inspektoru
za Zeleznicki saobracaj. Prijava mora da sadrzi
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sledece podatke:

1. opis nesrece ili nezgode;

2. datum i vreme (¢as i minut) nastanka nesrece
ili nezgode;

3. mesto nesrece ili nezgode (naziv sluZbenog
mesta, kilometarski poloZaj otvorene pruge,
objekat i sl.);

4. podatke o usmréenima, povredenima i materi-
jalnoj Steti;

5. ako je nastalo ugroZavanje okoline, navesti ka-
kvo (curenje opasnih materija i sl.);

6. aktivirane mere za spasavanje, angazovanje
sluzbi hitne pomodi, policije itd.;

7. podatke o vozovima ili manevarskim sastavi-
ma;

8. opis infrastrukturnih podsistema na mestu
nesrece ili nezgode;

9. vremenske uslove i geografske karakteristike
terena;

10. dali je nastalo zakréenje susednih koloseka;

11. preuzete mere radi zaStite i osiguranja mesta
nesrece ili nezgode;

12. podatke o Zeleznickom osoblju i izvodacima
radova koji su ukljuceni u nesrecu ili nezgode i
prisutnim svedocima;

13. podatke o podnosiocu prijave;

14. druge relevantne podatke.

Pored toga upravlja¢ Zeleznicke infrastrukture i

prevoznik dostavljaju pisanu prijavu Centru za

istrazivanje nesre¢a u saobracaju i republickom
inspektoru za Zeleznicki saobracaj elektronskim

putem u roku od 24 sata od nastanka nesrece ili

nezgode u Zeleznickom saobracaju. Pisana prijava,

pored osnovnih (prethodno navedenih) podataka,
mora da sadrzi:

1. detaljan opis nesrece ili nezgode;

2. detaljne podatke o vozovima i njihovom sas-
tavu (brojeve vozova, relaciju saobracaja, indi-
vidualne brojeve vu¢nih i vucenih vozila, tova-
reno/prazno, vrsta tovara);

3. detaljan opis infrastrukturnih podsistema na
mestu nesrece ili nezgode;

4. broj usmrcenih i/ili povredenih lica, sa naz-
nakom da li su Zeleznicko osoblje, putnici, iz-
vodaci radova ili treca lica;

5. podatke o materijalnoj Steti (na ¢emu je nasta-
la i, po moguénosti, procena Stete);
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6. podatke o prekidu saobracaja, o zakaSnjenju i
otkazivanju vozova, da li je nastalo zakréenje
susednih koloseka;

7. upotrebljena sredstva za otklanjanje posledica
i pruzanje pomo¢i nastradalima;

8. podatke o ustanovama za pruzanje medicinske
pomoci, policiji i drugim organima i sluZzbama
koji su izasli na mesto nesrece ili nezgode;

9. detaljan opis preduzetih mera za osiguranje

mesta nesrece ili nezgode;

sve druge relevantne podatke kojima se raspo-

laZe u vezi sa nesrecom ili nezgodom.

10.

Ovi podaci su od izuzetnog znacaja za obradu i do-
kumentovanje dogadaja u slucaju nesreca ili nez-
goda u Zeleznickom saobracaju [2].

3. OBRADA BAZE PODATAKA O
SAOBRACAJNIM NESRECAMA

3.1. Tabela PPP na prugama u Srbiji

Excel tabela svih putno-pruznih prelaza (tabela 1)
na mreZi pruga u Republici Srbiji sadrzi sledece
podatke: Sifru pruge, broj pruge na kojoj se posma-
trani putno-pruzni prelaz nalazi, naziv pruge, ZOP
kome pripada, kolosec¢nost pruge, broj koloseka
na putno-pruznom prelazu, Sirinu putno-pruznog
prelaza, povrsinu putno-pruznog prelaza, kilome-
tarski poloZaj, ime nadleZne stanice za odgovara-
juéi putno-pruzni prelaz, nacin osiguranja kao i
ostale relevantne podatke, imala je klju¢nu ulogu
u izradi ovog rada.

Tabela 1. Deo prikaza evidencije putno-pruznih prelaza u Srbiji
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1 (108 1 |MG| Bgd.-Resnik-Podgorica-Bar | Valjevo | ] | 1 [6.0|36.0| 0+431.00| Resnik |3 | 4 | 90 | da | ulica |ne| 1
2 [108| 1 IMG| Bgd.-Resnik-Podgorica-Bar | Valjevo | ] | 1 {3.0|18.0| 8+012.00| B.Reka |1 | 4 | 90 | da |poljski|ne| 1
3 [108| 1 [IMG| Bgd.-Resnik-Podgorica-Bar | Valjevo | ] | 1 |3.0|18.0{19+315.00f V.Borak [1| 2 | 90 | da |poljski|ne| 1
4 1108| 1 [MG| Bgd.-Resnik-Podgorica-Bar | Valjevo | ] | 1 |9.0(54.0(20+497.00| V.Borak [3 | 2 | 60 |da |lokalni|ne| 1
5 108 1 |MG| Bgd.-Resnik-Podgorica-Bar | Valjevo | ] | 1 {3.0{18.0{21+942.00| V.Borak |1 | 4 | 90 | da |poljski|ne| 1
6 |108| 1 [MG| Bgd.-Resnik-Podgorica-Bar | Valjevo | ] | 1 |6.0(36.0(24+269.00| V.Borak |3 | 4 | 90 | da |lokalni|ne| 1
7 |108| 1 |MG| Bgd.-Resnik-Podgorica-Bar | Valjevo | ] | 1 {3.0{18.0{25+321.00| V. Borak | 1| 4 | 90 | da |poljski|ne| 1
8 [108| 1 IMG| Bgd.-Resnik-Podgorica-Bar | Valjevo | ] | 1 |4,5]|30.0|27+708.00|Stepojevac| 1 | 4 | 90 | da |poljski|ne| 1
9 [108| 1 [MG| Bgd.-Resnik-Podgorica-Bar | Valjevo | J | 1 |3.0|18.0/28+547.00|Stepojevac| 1 | 2 | 90 | da |poljski|ne| 1
10|108| 1 |[MG| Bgd.-Resnik-Podgorica-Bar | Valjevo | | | 1 {4.0]24.0{29+952.00|Stepojevac| 1 | 2 | 90 | da |poljski|ne| 1
11|108| 1 |[MG| Bgd.-Resnik-Podgorica-Bar | Valjevo | ] | 1 {4,5[27.0{31+198.00|Stepojevac| 1 | 2 | 90 | da |poljski|ne| 1
13(108| 1 |MG| Bgd.-Resnik-Podgorica-Bar | Valjevo | ] | 1 [4,5|30.0{33+484.00|Stepojevac| 3 | 2 | 90 | da |lokalni|ne| 1
14)108| 1 |[MG| Bgd.-Resnik-Podgorica-Bar | Valjevo | ] | 1 [6.0(36.0{35+250.00| Vreoci |3 | 2 | 90 | da |lokalni|ne| 1
15(108| 1 |MG| Bgd.-Resnik-Podgorica-Bar | Valjevo | ] | 1 [6.0|36.0{38+516.00| Vreoci |3 |5,2| 90 | da |lokalni|ne| 1
16|108| 1 |[MG| Bgd.-Resnik-Podgorica-Bar | Valjevo | ] | 1 [6.0(36.0{42+656.00| Lazarevac | 3 |5,2| 60 | da |lokalni|ne| 1
171108 1 |[MG| Bgd.-Resnik-Podgorica-Bar | Valjevo | ] | 1 {6.0(36.0{46+822.00| Lazarevac | 1 |5,2| 90 | da |lokalni|ne| 1

3.2. Tabele evidentiranih nesreca i nezgoda

Eksel tabele o evidentiranim nesre¢ama i nez-
godama (tabele 2.1 3.) koriste se kao glavni izvor

podataka, a od podataka poseduju datum, vreme,
mesto nesrece, broj pruge, vrstu i uzrok nesrece, kao
i kratak opis vanrednog dogadaja, broj usmréenih i
povredenih lica, kao i podatke o troskovima koji su
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nastali pri nesre¢ama i nezgodama [3].

Pri izradi rada akcent je stavljen na kori$¢enje obe
baze podataka, ali je preciznije proucavanje us-
mereno na analizu nesreca i incidenata koji su se
desili na PPP. Primenom metoda i tehnika u QGIS
softveru izvrSena je detaljna obrada tih podataka

na identifikaciju i analizu specificnih slucajeva
nesreca koje su se odigravale na prelazima u oda-
branom periodu od pet godina. Ova analiza je omo-
gucila dublje razumevanje dinamike i uzroke inci-
denata na prelazima, Sto je od suStinskog znacaja
za dalje unapredenje bezbednosti i efikasnosti up-
ravljanja saobrac¢ajem na Zelezni¢kim prese¢nim

o pojedinim relevantnim dogadajima, sa fokusom tackama.

Tabela 2. Deo prikaza evidentiranih Saobracajnih nesreca u Srbiji

Usmréeno| Povredeno
=
N -
= =
« © § 5
s| ¥ g| 5|8 g5 E|g|E| Steta
Datum |Vreme| Mesto | @| & Kratak opis = IR|Z(Z2 = |5 S
SIS HIEEIEEEEREIR: (RSD)
S| 98219 9| &% -
=slEl%|z| E12] B
N N Al
St
a
Pri manevri isklizla kola br. 31724775006-8 na
1/1/2018| 13:05 | Pozega | 3|36 skretnici br. 33 121,448.00
Na PP u km 62+008 pad drumskog vozila na prugu,
1/4/2018| 3:30 Ruma |16|58 prekid saobracaja 2 188,137.00
1/4/2018| 8:14 | Palanka [16(48 Nestanak napona, izgoreo naponski trafo 1
U km 60+870 i 60+500 polomljena Sina i na vise
1/5/2018| 6:35 Senta (16|31 mesta otkinuta glava Sine 28
Pri manevri isklizla lok 621-301 izmedu skretnica br.
1/5/2018| 15:45 | Beograd | 3(36 22123
Na 2. koloseku doslo do samopokretanja kola br.
1/5/2018| 23:00 | Beograd [16(13 50722076008-0
Pucanje man. sastava kod kola br. 8072-3924214-0 i
1/6/2018| 2:25 | Brvenik [16(27 317239 24109-2 456,311.00
U km 107+000 usmrceno trece lice od strane voza br.
1/6/2018| 10:08 | Lapovo | 5[58 6731 1 2
. PoZar na gariranim kolima na 4. koloseku izazvan od
1/6/2018| 17:35 | PoZarevac| 6|6 strane trecih lica 12,022,605.00

Tabela 3. Deo prikaza obradenih podataka sluzbenih mesta sa najve¢im brojem nesre¢a na putno-pruz-
nim prelazima u periodu od 2016-2020.

Datum |Vreme|Sluzbeno mesto KilometarskKi polozaj i kratak opis Pruga|Steta (RSD) Odgovornost
3-Jan | 19:26 Ruma U km 62+008 nalet drumskog vozila na postavnu spravu PP[ 101 | 153,189.00] Vozac¢ drumskog vozila
5-Feb | 19:03 U km 62+008, na PP PBK 2, pad drumskog vozila na prugu| 101 77,473.80| Vozac¢ drumskog vozila

29-Aug| 6:44 U km 3+285 nalet voza br. 5223 na drumsko vozilo 211 | 123,000.00] Vozac¢ drumskog vozila

27-Nov| 22:00 U km 62+008, na PP PBK 2, pad drumskog vozila na prugu | 101 10,933.00] Vozac drumskog vozila

27-Dec| 3:50 U km 62+008, na PP PBK 2, pad drumskog vozila na prugu | 101 S-79

31-Dec| 3:50 U km 62+008, na PP PBK 2, pad drumskog vozila na prugu | 101 S-79
9-Jan [ 12:39 | Pancevo Varos | Na PP u km 0+907 nalet voza br. 7009 na drumsko vozilo | 309 0] Vozac drumskog vozila
11-Feb| 8:36 Na PP u km 17+544 nalet voza br. 7005 na drumsko vozilo| 107 0| Vozac drumskog vozila
17-Jan | 14:05 Kula Na PP u km 46+200 nalet voza br. 6422 na drumsko vozilo | 307 | 260,075.30] Voza¢ drumskog vozila
16-Jul [ 19:40 Na PP u km 39+000 nalet voza br. 4627 na drumsko vozilo| 307 49,000.00] Vozac¢ drumskog vozila
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Tabela 5. Prikaz broja saobraéajnih nesre¢a na
putno-pruZnim prelazima odgovarajucih pruga

Broj pruge Broj nesrec¢a
101 29
102 40
103 6
105 9
106 14
107 9
108 14
109 10
110
111
202 6
207 10
208 1
211 33
213 8
216
218 9
219 11
223 8

Ukupno 227

Uz pomo¢ ovako sortiranih podataka veoma je
lako da se utvrdi najopterecenija pruga na pod-
rucju celokupne Zeleznicke infrastrukture, kao i
opterecenje svih ostalih pruga ako se uporeduju
sve pruge na Zeleznickoj mreZi jedne sa drugom
(slika 3).

Broj nesreca u Loznici u periodu od 2016 do 2020 god.

1
A '

2016 god. 2017 god. 2018 god. 2019 god. 2020 god.

Slika 3. SluZbeno mesto sa najvecim brojem
nesreca u periodu od 2016. do 2020. godine
(Loznica) [6]

4. QGIS
4.1. Uvod u QGIS

QGIS, poznat i kao Quantum GIS, geografski je
informacioni sistem (GIS) otvorenog koda (sto-
ga i besplatan), koji omoguc¢ava korisnicima da
kreiraju, ureduju, vizualizuju, analiziraju i objav-
ljuju prostorne informacije. QGIS podrzava Sirok
spektar vektorskih, raster i baznih formata poda-
taka, ukljucujuéi format baze podataka PostGIS.
Kao projekat otvorenog koda, QGIS je razvijala
i odrzavala globalna zajednica programera i ko-
risnika [4].

QGIS se koristi za razlicite svrhe, od osnovne kar-
tografije do slozenih prostorno-analitickih zada-
taka. Njegova fleksibilnost i proSirivanje ga ¢ine
pogodnim za Sirok spektar korisnika, ukljucujuci
istraZivaCe, planere, inZenjere, obrazovne insti-
tucije, vladine agencije i neprofitne organizacije.

4.2. Osnovne Funkcije QGIS-a

QGIS omogucava korisnicima da kreiraju i ureduju
vektorske slojeve, podrzavajuci razliCite geometri-
je poput tacaka, linija i poligona (slika 4). Takode,
podrzava direktno uredivanje podataka u bazama
podataka poput PostGIS-a [4].

Database schema Table
3 [@import Layerfrile... EExporttoFile

SEDBARNYBNS 5;

Slika 4. Prikaz naseljenih mesta na podrudju cele
planete u QGIS softveru

QGIS pruza veoma mocne alate za vizualizaciju

podataka. Korisnici mogu da prilagodde stilove

slojeva, pritom da koriste razliCite simbole,

boje, oznake i da kreiraju sloZene karte koje
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prikazuju razlic¢ite aspekte prostornih podata-
ka (slike 5.1 6).

b G ER T M=
Qee -~ B

& LUOR §-8- &
=

Slika 5. Vizuelni prikaz podataka na teritoriji
Srbije u QGIS softveru

v QERIM-=-fe-

L LNV AY 1 sSiq= Qe ~

i N
Conr 2 s |8 S 1900+ | @

Slika 6. Vizuelni prikaz stanice Beograd Centar u
QGIS softveru

Analiza. QGIS ukljucuje alate za prostornu analizu,
ukljucujuci geo procesiranje, analizu mreza, raster
analizu i analizu statisti¢kih podataka. Integracija
sa GDAL/OGR bibliotekom dodatno prosiruje mo-
guénosti analize.

Prosirenja i Plaginovi. Jedna od klju¢nih sna-
ga QGIS-a je podrska za proSirenja i plaginove
(slika 7). Korisnici mogu instalirati dodatne
module za specificne zadatke, kao $to su ana-
lize vodnih tokova, prostorno modelovanje ili
integracija sa drugim GIS platformama [4].

4.3. Istorijat QGIS-a
QGIS projekat je zapoceo 2002. godine Gary

Sherman, koji je Zeleo stvoriti besplatan GIS
alat koji bi mogao raditi na viSe platformi.

SEPTEMBAR 2024

Prva verzija QGIS-a (v0.1) objavljena je u julu
2002. godine. Ova prva verzija je bila prilicno
osnovna, sa ograni¢enim funkcionalnostima,
ali je postavila temelje za dalji razvoj [4].

x Plugins | All (312)

& A search
B installed 3 Accuracy Assessme!

24 AccurAssess
2 Affine Transformatic

Accuracy Assessment

L Generate an error matrix and measures of mapping

s o FOR QIS accuracy for raster and reference data.

2 ArcheoCAD

) i Area Along Vector
ﬁ settings 3% Arrows

2 Astrogeology POW
¥ Attribute painter
¥ autosaver

¥ AutoTrace

2% Upgradeable

¥ 3 rating vote(s), 18723 downloads

Tags: confusion matrix,error matrix,accuracy assessment,remote
sensing,map comparison
More info: homepage tracker code repository
¥ Azimuth and Distanc
[ P Azimuth and Distanc
24 BLN Exporter
2% Blurring
2 Buffer by Percentag
¥ Bulk vector export |,

Author: Jared Kibele

Available version: 0.4.2 (in QGIS Official Plugin Repository)

Upgrade all Install plugin

Help close

Slika 7. Prozor sa plaginovima u QGIS softveru

Kroz godine, QGIS je prosao kroz znacajan razvoj

i evoluciju. Kako se zajednica korisnika i progra-

mera Sirila, tako su se Sirile i funkcionalnosti

QGIS-a. Neki od kljutnih momenata u razvoju

QGIS-a ukljucuju:

e 2004. godina: QGIS postaje GIS aplikacija koja
podrZava vise platformi, uklju¢uju¢i Windows,
Linux i macOS.

e 2006. godina: Dodavanje podrske za plaginove,
$to omogucava korisnicima i programerima da
prosire funkcionalnost QGIS-a prema potreba-
ma.

e 2008. godina: Integracija sa GRASS GIS-om, Sto
omogucava korisnicima pristup mo¢nim alati-
ma za prostornu analizu i modeliranje.

e 2010.godina: Objavljena verzija 1.5 koja dono-
si znacajna unapredenja u interfejsu i perfor-
mansama.

e 2013. godina: Objavljena verzija 2.0, koja uvo-
di mnoge nove funkcionalnosti i poboljSanja u
korisni¢kom interfejsu.

e 2018. godina: Objavljena verzija 3.0, koja
donosi mnoge tehnoloske inovacije, ukljucu-
juéi podrsku za 3D vizualizacije i unapredeni
alat za crtanje [4].

4.4. QGIS Danas

Danas, QGISjejedan od najpopularnijih i najmo¢ni-
jih GIS alata na svetu, sa aktivnom i posveenom
zajednicom koja kontinuirano radi na njegovom
unapredenju i razvoju. Ovaj softver se Siroko ko-
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risti u raznim sektorima kao Sto su urbanizam,
poljoprivreda, zaStita Zivotne sredine, transport,
telekomunikacije, hidrologija, istrazivanje prirod-
nih resursa, planiranje infrastrukture i dr.

QGIS se istice svojom integracijom sa brojnim dru-
gim otvorenim GIS alatima i platformama, kao $to
su GRASS GIS, SAGA GIS i PostGIS, sto omogucava
korisnicima da iskoriste Sirok spektar funkcional-
nosti i resursa za analizu i obradu prostornih po-
dataka. Ova integracija ¢ini QGIS veoma moénim
i fleksibilnim alatom, sposobnim da odgovori na
razlicite potrebe i zahteve korisnika.

Jedna od najvec¢ih prednosti QGIS-a je njegova
pristupacnost. Kao besplatan softver otvorenog
koda, QGIS omogucava svim korisnicima, bez ob-
zira na njihove finansijske moguénosti, pristup na-
prednim GIS alatima i resursima. Ovaj pristupacan
model omogucéava Siroku upotrebu u akademskim
institucijama, istrazivackim organizacijama, nevla-
dinim organizacijama i manjim preduzeéima koja
moZda nemaju resurse za skupe komercijalne GIS
softvere.

Pored toga, otvorenost i transparentnost QGIS-a
omogucavaju korisnicima da prilagode i prosire
softver prema svojim specificnim potrebama. Ko-
risnici mogu razvijati sopstvene plagine i dodatke,
Sto ¢ini QGIS izuzetno fleksibilnim i prilagodljivim
alatom za rad sa prostornim podacima. Zajednica
korisnika i programera neprekidno doprinosi raz-
voju novih funkcionalnosti, popravci gresaka i po-
boljsanju performansi, Sto osigurava da QGIS os-
tane aktuelan i u skladu sa najnovijim tehnoloskim
trendovima i zahtevima.

Kroz razne obuke, radionice i onlajn resurse, QGIS
zajednica promoviSe edukaciju i obuku novih ko-
risnika, $to dodatno podstice Sirenje i upotrebu
ovog softvera Sirom sveta. QGIS je danas vise od
softvera - to je platforma za inovacije, saradnju i
razmenu znanja u oblasti geoinformatike i pros-
tornog planiranja.

Zahvaljuju¢i svim ovim karakteristikama i pred-
nostima, QGIS se pozicionirao kao klju¢ni alat u
savremenom upravljanju prostornim podacima i
analizama jer omogucava korisnicima da efikas-

no i efektivno upravljaju svojim prostornim infor-
macijama i donose informisane odluke [4].

4.5. Mogucnosti primene QGIS sistema

QGIS (Quantum GIS) mocan je geografski infor-
macioni sistem otvorenog koda koji nudi Sirok
spektar mogucnosti za rad sa prostornim podaci-
ma [5]. Ova aplikacija se cesto koristi u istraziva-
njima, planiranju, upravljanju resursima i drugim
oblastima koje zahtevaju analizu i vizualizaciju
geografskih informacija. Pregled nekih klju¢nih
mogucénosti i sposobnosti koje QGIS nudi:

¢ Geo prostorne analize. QGIS omogucava iz-
vodenje razli¢itih geoprostornih analiza kao
Sto su upiti za prostorne podatke, analiza pros-
torne distribucije, analiza udaljenosti, analiza
rute i mnoge druge. Ove analize pomaZu u ra-
zumevanju prostornih relacija i obrazaca.

e Vizualizacija podataka. MozZete kreirati di-
namicke i interaktivne karte koristeci razlicite
slojeve podataka. QGIS podrzava razliCite vrste
podataka kao Sto su vektorski, raster i tabelar-
ni podaci, omogucavaju¢i vam da kombinujete
razlicite izvore i vrste podataka u vasim mapa-
ma.

¢ Uredivanje podataka. QGIS omogucava
uredivanje vektorskih podataka direktno u ap-
likaciji. MoZete dodavati, izmenjivati i brisati
geografske objekte, Sto je korisno za kreiranje i
azuriranje geografskih podataka.

e Podrska za razlic¢ite formate podataka.
QGIS podrZava veliki broj formata podataka,
uklju€uju¢i Shapefile, GeoPackage, PostGIS,
kao i mnoge druge formate vektorskih, raster
i tabelarnih podataka. Ovo ¢ini QGIS veoma
fleksibilnim za rad sa razli¢itim izvorima po-
dataka.

¢ Prostorne baze podataka. QGIS ima podrsku
za povezivanje sa prostornim bazama poda-
taka kao Sto su PostgreSQL/PostGIS, SQLite,
Oracle Spatial, Sto omogucava efikasno uprav-
ljanje velikim koli¢cinama prostornih podataka.

e Alati za analizu i obradu podataka. QGIS
dolazi sa Sirokim spektrom alata za analizu
podataka kao $to su alati za raster analizu, za
interpolaciju, za povrSinsku analizu, za geo
procesiranje i mnogi drugi, Sto omogucava na-
predne analize podataka direktno u aplikaciji.
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e Ekstenzije i dodaci. QGIS ima veliku zajednicu
koja razvija ekstenzije i dodatke koji dodaju do-
datne funkcionalnosti aplikaciji. Ovi dodaci mogu
da obuhvate sve, od specijalizovanih alata za ana-
lizu do dodatnih opcija za vizualizaciju i obradu
podataka.

e Otvoreni kod i zajednica. Kao softver ot-
vorenog koda, QGIS je besplatan za koriSce- nje
i ima aktivnu zajednicu korisnika i razvojnih
timova koji doprinose njegovom odrZavanju
i razvoju. Ovo osigurava kontinuirano pobo-
ljSanje i podrsku za korisnike Sirom sveta [9].

Ove mogucnosti ¢ine QGIS svestranim alatom za
sve korisnke koji rade sa prostornim podacima,
bilo da su u pitanju naucno-istrazivacki projekti,
planiranje, upravljanje resursima ili neke druge
aplikacije koje zahtevaju upotrebu geografskih in-
formacionih sistema.

4.6. Mogucnosti primene QGIS sistema u
Zeleznickom saobracaju

U Zeleznickom saobracaju, efikasno upravljanje i
planiranje infrastrukture su klju¢ni za osigurava-
nje bezbednosti i ekonomske efikasnosti. Upravo u
ovom kontekstu, Quantum GIS (QGIS) pokazao se
kao mocan saveznik inZenjera, planera i analiticara,
omogucavaju¢i im da detaljno analiziraju prostorne
podatke i da donesu informisane odluke (slika 8).

Slika 8. Planiranje i optimizacija trase u QGIS
softver-u

Planiranje i optimizacija trase: QGIS omogucava
detaljno modeliranje i analizu terena duz potenci-
jalnih Zeleznickih trasa. Koriste¢i digitalne visinske
modele (DEM) i alate za analizu terena, inZenjeri
mogu optimizovati trase kako bi minimizirali nagibe,
smanjili troSkove gradnje i smanjili uticaj na Zivot-
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nu sredinu. Ovo je od klju¢ne vaznosti pri planiranju
novih pruga ili pri rekonstrukciji postojecih.

Analiza bezbednosti na prelazima: Bezbednost na
putno-Zeleznickim prelazima je jedan od najbitnijih
aspekata ZeleznicCke infrastrukture. QGIS omoguca-
va analizu saobracajnih tokova, gustine naseljenosti i
karakteristike prelaza kako bi se identifikovala rizic-
na mesta i predloZila unapredenja koja bi povecala
bezbednost korisnika i vozova.

Upravljanje imovinom i odrzavanje infrastruk-
ture: Efikasno upravljanje Zeleznickom infrastruk-
turom zahteva pracenje lokacija imovine, planira-
nje redovnog odrzavanja i brzu reakciju na potrebe
odrzavanja. QGIS pruza alate za detaljno upravljanje
imovinom, $to omogucava efikasno planiranje resur-
sa i produZenje radnog veka infrastrukture.

Optimizacija operacija i analiza kapaciteta: Ana-
liza kapaciteta Zeleznickih pruga je klju¢na za optimi-
zaciju rasporeda vozova i efikasnost operacija. QGIS
omogucava analizu kapaciteta, Sto pomaze boljem
razumevanju opteretenja mreze i identifikacija po-
tencijalnih uskih grla ili problema sa kapacitetom.

Integracija sa drugim sistemima: QGIS se lako inte-
griSe sa drugim sistemima za upravljanje Zeleznickim
saobracajem, kao $to su informacioni sistemi o redu
voZnje ili sistemi za pracenje vozova. Ova integracija
omogucava pracenje vozova u realnom vremenu, bo-
lju koordinaciju operacija i efikasniju razmenu infor-
macija izmedu razlicitih operativnih jedinica.

QGIS se stoga pokazao kao neophodan alat za mo-
dernizaciju i unapredenje Zeleznickog saobracaja
(slika 9) jer omogucava strucnjacima da precizno
modeliraju, analiziraju i optimizuju infrastrukturne
projekte za stvaranje sigurnog, efikasnog i odrzivog
Zeleznickog sistema.

Slika 9. 3D prikaz Zeleznicke stanice u QGIS
softveru
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5. OBRADA PODATAKA KORISCENJEM
QGIS-A

5.1. Kreiranje novog projekta u QGIS-u

Kreiranje novog projekta u QGIS-u predstavlja os-
novu za svaki geografski informaticki rad i is-
trazivanje. Ovaj proces zapocinje pokretanjem QGIS
aplikacije na racunaru (slika 10). Po otvaranju pro-
grama automatski se kreira novi prazan projekat,
spreman za dodavanje podataka i pocetak rada.
Ukoliko Zelimo da zapo¢nemo novi projekat tokom
rada, jednostavno biramo opciju Project > New ili
kliknemo na ikonu New Project na alatnoj traci.

Y- AEHIE =
Qe®R -~ B
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Slika 10. Kreiranje novogm};roj‘ekta u QGI.§ softveru
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Da bi se izbegao gubitak podataka, QGIS nudi op-
ciju automatskog Cuvanja projekta, koja se moze
aktivirati kroz Settings > Options > General, gde se
Cekira opcija Enable auto-save of project. Takode,
preporucuje se da svi podaci povezani sa projektom
budu organizovani u jednom direktorijumu, ¢ime
se izbegavaju problemi sa putanjama do datoteka.

Kreiranje i ¢uvanje projekata u QGIS-u je proces
koji zahteva veliku paznju, ali pri tom pruza veoma
mocne alate koji sluZe za obradu i analizu razli¢itih
geografskih podataka. Redovnim c¢uvanjem i do-
brom organizacijom podataka moZemo osigurati
da rad bude efikasan i da rezultati budu tac¢ni i pou-
zdani.

5.2. Graficki korisnicki interfejs QGIS-a

Pocetni interfejs QGIS-a je sastavljen od nekoliko
klju¢nih elemenata, koji omogucéavaju korisnici-
ma da efikasno rade sa geografskim podacima
(slika 11). Glavne komponente pocetnog interfejsa
QGIS-a su:

e g | Py
(5) oo s s | Sk« @ e oo o (0073 v Aoty @wster @

Slika 11. Pocetni interfejs QGIS softvera i kljucni
elementi koji ga sacinjavaju

Meni Bar (Menu Bar)

Ovaj deo se nalazi na vrhu interfejsa i sadrzi os-
novne menije kao Sto su File, Edit, View, Layer,
Settings, Plugins, Vector, Raster, Database, Web,
Processing i Help. Svaki meni sadrZi razlic¢ite op-
cije za upravljanje projektom, uredivanje slojeva,
podesavanje interfejsa i druge funkcije.

Alatna Traka (Toolbars)

Alatne trake su smestene ispod menija i sadrze
ikone za brzi pristup cesto koris¢enim alatima i op-
cijama. Postoji vise alatnih traka, ukljucujuci alatne
trake za upravljanje projektom, navigaciju mapom,
alatke za uredivanje i druge specifi¢ne funkcije.

Panel za Slojeve (Layers Panel)

Ovaj panel se obi¢no nalazi sa leve strane i pri-
kazuje listu svih slojeva koji su dodati u projekat.
Omogucava korisnicima da ukljucuju/iskljucuju
vidljivost slojeva, menjaju redosled slojeva i pris-
tupaju opcijama za uredivanje slojeva.

Mapa (Map Canvas)

Glavni deo interfejsa gde se prikazuju svi slojevi
i podaci. Korisnici mogu da zumiraju, pomeraju i
sprezu sa mapom u ovom prostoru. Mapa je cen-
tralno mesto za vizualizaciju geografskih podataka.

Statusna Traka (Status Bar)

Smestena na dnu interfejsa, statusna traka prika-
zuje informacije kao S$to su trenutne koordinate
pokazivaca misa, skala mape i status zadataka koji
su u toku.

Panel Alatki (Processing Toolbox)
Ovaj panel sadrzi Sirok spektar alata za prostorne
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analize i geoprocesiranje. Omogucava pristup
alatima za obradu vektorskih i rasterskih poda-
taka, kao i dodatnim funkcijama koje se mogu in-
stalirati kroz plaginove.

Browser Panel

Panel koji omogucava pretragu i pregled podataka na
lokalnom disku, kao i podataka sa udaljenih izvora.
Ovo olakSava dodavanje novih slojeva u projekat.

Konzola (Python Console)

Ovaj panel omogucava korisnicima da piSuiizvrsa-
vaju Python skripte direktno u QGIS-u. Koristan je
za automatizaciju zadataka i napredne analize.

Ovi elementi zajedno Cine fleksibilan i moc¢an in-
terfejs QGIS-a, omogucavajuéi korisnicima da efi-
kasno rade sa svojim geografskim podacima [4].

5.3. Proces Kreiranja Sloja (lejera) i Mape
u QGIS-u

Rad sa geografskim podacima u QGIS-u pocinje krei-
ranjem novih slojeva i u¢itavanjem mapa iz razli¢itih
izvora. Ovi koraci su osnova za sve buduce analize i
vizualizacije koje se mogu izvrsiti u ovom alatu (slika
12). Evo kako se to radi, korak po korak [4].

2\ New Shapefile Layer X

File name ‘Sve regije Stbije .shp all..
File encoding UTF-8 v
Geometry type (2 polygon v
Additional dimensions @) None Z(+ Mvalues) M values

EPSG:4326 - WGS 84 - A&
New Field

tane s ‘

Type | abe Text (string) v
Length 80 Predision
) Add to Fields List
Fields List

Name Type Length Precision
id Integer 10

o [ ol ™3

Slika 12. Kreiranje novog sloja (lejera) u QGIS
softver-u
Kada pokrenemo QGIS, kreiranje novog vektor-
skog sloja je prvi korak, to se postiZe izborom op-
cije Layer > Create Layer > New Shapefile Layer..
ili New Geopackage Layer... iz glavnog menija. U
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dijalogu koji se otvori, biramo tip geometrije koju
Zelimo da koristimo, bilo da su to tacke, linije ili
poligoni. Ovde takode moZemo dodati atribute
koji ¢e biti povezani sa ovim geometrijama, kao
Sto su naziv, tip ili bilo koji drugi podatak koji je
relevantan za nas projekat.

Nakon definisanja atributa i izbora lokacije za sni-
manje sloja, klikom na OK na$ novi sloj ¢e se po-
javiti u Layers panelu i biti spreman za uredivanje.
Da bismo dodali podatke u ovaj sloj, aktiviramo
alatku za uredivanje klikom na ikonicu olovke na
alatnoj traci. KoriS¢enjem alatki za crtanje, moZe-
mo dodati nove geometrije u sloj i uneti atribute
za svaki novi element.

Instaliranje OSM plagina predstavlja slede¢i korak
ako ranije nije instaliran (slika 13). Ova instalacije
postiZe se izborom komande Plugins > Manage and
Install Plugins... i pretraZivanjem opcije OpenStreet-
Map ili QuickMapServices. Nakon instalacije, moZe-
mo dodati OSM mapu izborom komande Web >
QuickMapServices > OSM > OSM Standard iz menija.

» Aino 5
% Animate OSM All Plugins

 Calic
2 Notinstalled # Datasud
# Go2NextFeaturePlus
> # HCMGIS
*» rew % imporerzsibasemap
‘. Lat Lon Tools
- e % MapTiler
# Nominatim Locator Filter
# ORS Tools
% OSM place search
2 OSM SidewalKreator
% OsmAnd bridge
v~ OsMDownloader
#OSMinfo
» osmpoly_export
 Pelias Geocoding
# Power Pin PL
V @ QuickMapSenvices
VIEIQuickOSM
# Route Builder
# Valhalla

e,
3 instalied

On the left you see the list of all plugins available for your QGIS, both
installed and available for download. Some plugins come with your QGIS
installation while most of them are made available via the plugin
repositories.

You can temporarily enable or disable a plugin. To enable or disable a
plugin, click its checkbox or double-click its name.

Plugins showing in red are not loaded because there is a problem. They
are also listed on the 'Invalid" tab. Click on the plugin name to see more

% install from ZIP
details, or to reinstall or uninstall this plugin.

Upgrace Al Uninstal Pugin Reinstal Plugin

Slika 13. Instaliranje OSM plagina u QGIS softveru

Ako Zelimo ru¢no da dodamo OSM mapu, moZemo
koristiti WMS ili XYZ Tile. Za ovaj proces idemo
na Layer > Add Layer > Add WMS/WMTS Layer...
ili Add XYZ Layer... i unosimo URL: https://tile.
openstreetmap.org/{z}/{x}/{y}.png, koji naziva-
mo “OSM”. Klikom na OK, ovaj sloj se pojav- ljuje u
Layers panelu.




ZELEZNICE

Primena QGIS softvera za obradu podataka o putno-pruZznim prelazima

Dodavanje drugih izvora mapa je takode moguce ko-
riS¢enjem istih koraka kao i za OSM, ali sa razli¢itim
URL-ovima za druge WMS/WMTS ili XYZ Tile usluge.
Na primer, mnogi provajderi, kao Sto su Google i Bing,
nude javne mape koje mogu biti dodate na ovaj nacin.

Ucitavanje mape u QGIS kroz OpenStreetMap (OSM)
pruza korisnicima moguc¢nost da brzo pri-stupe
globalnim geografskim podacima. Ovaj proces je jed-
nostavan i omogucava korisnicima razli¢itih nivoa
iskustva da efikasno rade sa prostornim podacima.

Mapa se ubacuje tako Sto nakon instalacije plagina,
QGIS aplikacija otvara mogucnost za dodavanje OSM
Mape preko QuickMapServices. U meni baru nalazi se
opcija Web, gde izabirom QuickMapServices > OSM >
OSM Standard dodajemo Zeljene podatke. U QGIS-u
¢e se automatski ucitati OSM mapa u interaktivnom
okruZenju (slika 14). Kada se OSM mapa pojavi u
QGIS-u, mapu je moguce prilagoditi svojim potre-
bama, ukljuCuju¢i zumiranje na odredene oblasti,
promenu stilova prikaza ili dodavanje dodatnih slo-
jeva. Za istraZivanje i prilagodavanje mape, mogu se
koristiti alatke za navigaciju i uredivanje u QGIS-u.

Slekilded

Bl

44

birje

Codes
Crna Gora | @
ipHa lNopa
CeLinje

Sl pelpr o BNaroesrpay

LGOI

Slika 14. Prikaz mape Srbije putem OSM-a u QGIS
softver-u

5.4. Proces kreiranja sloja i dodavanja
pruga i putno-pruznih prelaza u QGIS-u

Prikupljanje podataka o prugama i putno-pruznim
prelazima predstavljalo je klju¢ni korak u ovom
istrazivanju. Koriste¢i podatke iz OpenStreetMap
(OSM) baze, obezbedene su geografske koordi-
nate i atributne informacije koje omogucavaju de-
taljnu analizu i vizualizaciju. Ovi podaci su zatim
integrisani u QGIS, $to omogucava sveobuhvatno
istraZivanje prostornih odnosa na teritoriji Srbije.
Iako je OSM veoma koristan plagin, pri dodavanju
PPP pokazao se jos uvek nedovoljno unapredenim
i zato su koris¢ene druge metode dodavanja vek-
torskih informacija u QGIS [8].

Nakon dodavanja sloja mape Srbije, prethodno
preuzete sa OSM-a, dodavanjem vektorskih slo-
jeva za pruge i putno-pruzne prelaze, zapocet je
proces vizualizacije i analize prostornih odnosa na
teritoriji Srbije u QGIS-u.

Dodavanje sloja za pruge

Dodavanje sloja za pruge pocinje izborom opcije
Layer iz glavnog menija QGIS-a, zatim Add Layer, i
na kraju Add Vector Layer (slika 15). Nakon toga,
u dijalogu za dodavanje slojeva, izabrana je opcija
Browse, kojom su pretrazeni lokalni fajlovi kako bi
se pronasao odgovarajuci vektorski fajl sa podaci-
ma o prugama. Ovi podaci su bili preuzeti u for-
matu Shapefile (.shp) iz OSM baze. Klikom na Add,
sloj pruga je dodat na mapu i odmah postao vidljiv
u Layers panelu.

s 50,5027 | § S il | @ vt a3 Rn (0003 v Bk @wmeny @

Slika 15. Dodavanje pruga u QGIS softveru

Dodavanje sloja za putno-pruZne prelaze
Slican postupak primenjen je za dodavanje sloja
putno-pruznih prelaza (slika 16). Pri tom pono-
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vo se Koristi opcija Add Vector Layer... iz menija
Layer, a zatim treba de se izabere opcija Browse
za pronalaZenje vektorskog fajla sa odgovaraju¢im
podacima o prelazima. Ovi podaci su takode bili
preuzeti iz OSM baze i saCuvani u formatu Geo-
JSON (.geojson). Klikom na Add, sloj prelaza je do-
dat na mapu i pojavio se u Layers panelu.

o
LUOR M-8 G5 GEXIE =&
Qe -

>
oo 367, 5moa | Sl s - | @ vopte 03 e

Slika 16. Dodavanje putno-pruZnih prelaza OSM
plaginom u QGIS softveru

Pri dodavanju puto-pruznih prelaza nailazimo na
lose unesene podatke u samom OSM-u, na pri-
kazanoj slici vidimo da su podaci o PPP uneseni
samo za podrucje Beograda, tako da unosenje put-
no-pruznih prelaza obavljamo drugom metodom.

5.5. Proces unosa geografskih tacaka
putem koordinata i putem koda u QGIS

Koris¢enje QGIS-a za unos tacaka pomocu koordi-
nata omogucava korisnicima da detaljno mapiraju
prostorne podatke u skladu sa njihovim potreba-
ma i zahtevima projekta. Ovaj proces je klju¢an u
geografskom informacionom sistemu za precizno
lociranje, kao i detaljnu analizu prostornih poda-
taka.

Ovaj proces unoSenja obavlja se tako Sto se prven-
stveno pronadu i defini[u odgovarajuce koordinate
tacke koju treba da se unese, u ovom slucaju to su
koordinate putno-pruznog prelaza, Sto je moguce
uraditi primenom Google Map-a. Zatim se piSe
kratak kod (slika 17) koji omogucava projektan-
tu da napravi odgovarajuci Query koji treba da se
implementira u rad (projekat). Kod za dodavanje
pointa (tacke) putem koordinate glasi:

SEPTEMBAR 2024

/*
Ovaj query daje nam point specificnih koordinata.

=/

[out:json];

(

node(44,279839,19.926429);
)

H
out body;
>
out skel qt;

/*
Puto-Pruzni prelaz u Loznici
=/
Slika 17. Kod Query-a za dodavanje tacke
putno-pruzZnog prelaza korisé¢enjem koordinata

Nakon kreiranja prethodnog koda (slika 18) ve-
oma je vazno da se kod saCuva u odgovaraju¢em
formatu, odnosno da se sa¢uva sa odgovaraju¢om
ekstenzijom za naziv datoteke tipa “gojson”, koja
projektantu omogucava da se novonastala datote-
ka pozove u funkciju tako Sto Sto ¢e projektant da
doda jedan novi sloj (lejer) pritiskom na opciju
Layer > Add Layer > Add Vector Layer....

Izborom odgovaraju¢e point.gojson datoteke,
QGIS ce je automatski da ucita sve odgovarajuce
podatke o putno-pruznom prelazu.

Y AERIE-®f
Q’ReR ~ B

SEDBABNIBES |

ot e e @ el - @ e o8] ron 003 ¢ ek Bosas @

Slika 18. Kreiranje fajla u kojem se nalazi Query

Nakon unoSenja odgovarajuceg Query-a u QGIS-u
se pojavljuje novi lejer sa unesenom funkcijom
koju projektant zadao. U studiji slucaja uradenoj
u ovom radu prezentovan je putno-pruzni prelaz u
Loznici koji se nalazi u km km:49+511 pruge 211
(slika 19).
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Slika 19. Prikaz putno-pruznog prelaza primenom
kreiranog Query-a u QGIS softveru

Ovim nacinom unoSenja puto-pruznih prelaza
dobijamo precizne i jasno vidljive podatke o put-
no-pruznom prelazu na teritoriji Srbije, ali nailaz-
imo na problem same efikasnosti primene krei-
ranja veceg broja putnih prelaza. Shodno tome
kreiramo novi kod i novi Query koji ¢e nam omo-
guctiti da mapiramo sve putno-pruzne prelaze u
nivou na teritoriji cele Srbije (slika 20).
[out:json][timeout:3e0];

// Fetch area "Serbia" to search in
{{geocodeArea:Serbia}}->.searchArea;

node["traffic_sign"~"railway_crossing|crossing"](area.searchArea);
node["railway"="crossing"](area.searchArea);
node["railway"="level crossing"](area.searchArea);

out body;

>

out skel qt;

Slika 20. Kod Query-a koji prikazuje sve
putno-pruzne prelaze u nivou

Kreiranjem ovog Query-a i njegovom implmentaci-
jom dobijamo pozicije svih putno-pruznih prelaza
u nivou na mrezi pruga na teritoriji cele Srbije
(slika 21).

Koris¢enje ove metode u QGIS-u je jedan od nacina
za efikasno upravljanje i manipulaciju podacima,
posebno kada se radi sa velikim koli¢cinama geo-
prostornih informacija ili kada Zelimo izvrsiti
specificne operacije koje nisu direktno podrzane
standardnim alatkama za obradu podataka u
QGIS-u. Pored putno-pruznih prelaza moguce je
dodati i ostale podatke kao Sto su poloZzaji stanica,
presek svih drumskih i Zeleznickih puteva i mnoge
duge (slike 22.1 23).
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Slika 21. Graficki prikaz svih putno-pruznih
prelaza u nivou u QGIS softveru
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Slika 22. Graficki prikaz stanica u Srbiji u QGIS softveru
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Slika 23. Graficki prikaz svih tacaka preseka drum-
ske i Zeleznicke infrastrukture u QGIS softveru

5.6. Vizualizacija podataka

Nakon uspeSnog dodavanja slojeva, pristupilo se
njihovoj vizualizaciji. Prvi korak bio je prilagoda-
vanje stilova slojeva kako bi se obezbedila jasna i
pregledna prezentacija podataka (slika 24).

2\ Layer Properties - Pruge Zeleznice Srbije u funkciji — Symbology

= Single Symbol =
~ =+ Line &
~ 11 Marker Line
~ 1 Marker
I Simple Marker
— Simple Line

Opacity 100.0%

Width | 1.60000 3 | Milimeters - €

Q Al symbols al~ 8
Name Tags =
Project sty...
Default
= cattrail  Showcase
- = dash b... Colorful, Grayscale
- = dashbl... Colorful
dash gr... Grayscale
dash gr... Grayscale
- - dashgr... Grayscale
- - dashgr.. Grayscale
- - dashgr... Colorful
- - dashred Colorful
[ effecte... Showcase
W effect .. Showcase -

Save Symbol... | | Advanced ~

D Layer Rendering

syle - oK Cancel Apply. Help

Slika 24. Kartica koja se koristi za uredivanje
izgleda pruga QGIS softvera
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Za prilagodavanje stilova sloja pruge, desnim kli-
kom na sloj u Layers panelu izabrana bira seopci-
ja Properties, a zatim kartica Symbology. Ovde je
podesSen stil pruge, uklju¢ujuéi boju (crna) i de-
bljinu linije (1.6 mm), kako bi pruge bile jasno vidl-
jive na mapi [4].

Za sloj putno-pruznih prelaza, takode je otvore-
na kartica Symbology iz prozora Layer Properties.
Prelazi su prikazani kao tac¢ke sa narandzastim kru-
govima, $to omogucava lako razlikovanje prelaza od
ostalih objekata na mapi (slika 25).

2 Layer Properties - export — Symbology

Q = single symbol -
G 3 ~ O Marker &
O simple Marker
33
W
o
an
@ Color I~
- B wow 3] &
N
PN s (200000 2] [ Miimeters MK=S
]
ﬁ Rotation | 0.00° €
L Al Symbols a -
£ s -
Project ty...
Default
ﬁ @ diamon... Colorful
@ diamon... Colorful
Q@ @ diamon... Colorful
@ dot bla... Colorful, Grayscale
® O dot wh... Colorful, Grayscale
V) @ dotblue Colorful
L J @ cotbro... Colorful
° @ dotgre... Colorful
@ dotora... Colorful =
= Save Symbol... | | Advanced
D Layer Rendering
= Style ( oK Cancel Apply. Help

Slika 25. Kartica za uredivanje izgleda
putno-pruznih prelaza QGIS softvera

5.7. Analiza podataka

Sa dodatim i vizuelno prilagodenim slojevima,
naredni korak bio je sprovodenje prostorne ana-
lize. Prva analiza fokusirala se na identifikaciju
gustine putno-pruznih prelaza. KoriS¢enjem Heat-
map alata generisana je toplotna mapa koja prika-
zuje koncentraciju prelaza, Sto je omogucilo iden-
tifikaciju podrucja sa najgu$¢om mreZom prelaza
(slika 26). Na osnovu te analize dobijamo podatak
na osnovu kojeg moZemo prikazati sve opStine u
Srbiji koje poseduju putno-pruzne prelaze, kao i
prugu koja poseduje najveci broj PPP (slika 27).

Rezultati primene prikaza toplotne mape prika-
zani su kroz boje i intenzitete na mapi i jasno su
oznatena podrucja sa najveom gustinom PPP.
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Slika 26. Graficki prikaz najvece kocentracije PPP na
prugama Srbije, u QGIS softveru (pruga 102)
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Slika 27. Graficki prikaz opstina koje poseduju
putno-pruzni prelaz u QGIS softveru

Analizom toplotne mape zakljuujemo da je pruga
Beograd - Ni$ - PreSevo (oznaka 102) pruga sa na-
jve¢im brojem PPP u Srbiji (slika 28). Ovaj podatak
je potvrden podacima koje je pruzila vizualizacija
podataka, kao i sama ¢injenica da smo taj podatak za
prugu 102 obradili u gore navedenim excel tabelama.
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Slika 28. Graficki prikaz pruge 102 i opStina kroz
koje prolazi pruga u QGIS softveru

Koris¢enje heatmap-e u QGIS-u se pokazalo kao efi-
kasan metod za istrazivanje i interpretaciju pros-
tornih podataka, pruzajuci dublji uvid u raspodelu i
zastupljenost PPP na prugama. Ovaj rad je naglasio
znacaj analitickih alata i vizuelnih tehnika u razume-
vanju prostornih obrazaca i donoSenju informisanih
zakljucaka na osnovu geoprostornih podataka [10].

5.8. Moguc¢nost prikaza podataka putem
HTML map tips -a u QGIS-u

U QGIS-u, jedan od nacina za interaktivno prikazivan-
je podataka na Kkarti je kroz koris¢enje HTML map
tips-a. Ova funkcionalnost omogucava korisnicima da
prilikom pomeranja misa preko tacke na karti dobi-
ju dodatne informacije ili vizuelne sadrzaje u obliku
HTML formatiranih prozora [9].
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Proces unoSenja podataka u HTML map tips se ost-
varuje tako Sto kliknemo desnim klikom na odgo-
varajuci lejer u panelu Layers (Slojevi) i izaberemo
Properties (Svojstva), zatim u prozoru svojstava,
pritiskom na karticu Display (Prikaz) otvaramo pro-
zor u koji unosimo Zeljene podatke u vidu teksta, slike
itd. HTML map tips poseduje posebnu gramatiku un-
oSenja podataka koja je prikazana na slici 29.
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Slika 29. Proces unosenja podataka primenom
HTML-a u QGIS softveru

Prikazivanje preko HTML map tips-a olakSava ra-

zumevanje prostornih podataka na viSe nacina:

1. Omogucava detaljnije informacije o karakter-
isticnim tackama na karti. Na primer, korisnici
mogu da vide atributne informacije kao Sto su
naziv, opis ili numericke vrednosti, Sto moze
biti klju¢no za analizu ili istraZivanje (slika 30).
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2. HTML map tips mozZe da ukljuci i graficke e-
lemente kao Sto su slike, dijagrami ili ¢ak in-
teraktivni grafici, ¢cime se dodatno poboljsava
vizualizacija podataka (slika 31).
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Slika 31. Vizuelni prikaz podataka o vanrednim

dogadajima na putno-pruznom prelazu u km
49+004 pruge 211

3. Ova funkcionalnost je posebno korisna za pre-
zentacije ili deljenje prostornih podataka sa
drugima jer omogucava intuitivan pristup de-
taljnim informacijama bez potrebe za ulaskom
u kompleksne tabele ili grafikone (slika 32).

Podgor

17.01.2017
¥ km 49+511, Ha N OcH. Ca06p.3HALMA Ha YTy ¥ 30HOM NOTDEGHE BUL. HaneT 803a 6. 48412 Ha APYMCKO BO3WN0.

Henaxtea 803242 ApyMCKor 803ua

06.10.2018
Ha 11y K1: 49+511 HaneT 803a 6p: 71220 Ha TePETHO APYMCKO BOSUNO.

Henaxtea 803242 ApyMcKor 803una

Crvka nyro-npyxHor npenasa :

Slika 32. Vizuelni prikaz podataka o saobracajnim
nesrecama na putno-pruznom prelazu u km 49+511
pruge 211

QGIS pruza mogu¢nost prilagodavanja HTML map
tips-a putem HTML i CSS kodiranja, Sto Korisnici-
ma omogucava da prilagode izgled i sadrzaj pre-
ma svojim potrebama ili korporativnom identitetu
(slike 33, 34.1 35).
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04.05.2018
Ha Ny K04:57+306 HaneT ADyMCKOr 80372 12 803 6p15435.

{ Henapisa sasasa ApyMcKor soTa

6 26.07.2018
\...‘ Ha MMy tor: 57+306 HaneT ApywcKor B03WTa Ha 33£¥bi A0 803 6p: 5434 (AMT 711-037/038).
078 enaxcta sosava apymaror soswna

K 57306 +a 11 0Ge36el)eroM 3+aLIMa Ha NYTY 1 30HOM NOTPESHE NPErNERHOCTH A0WINO Je A0 HaneTa 5033 6p0j 410 (711-051/052) Ha APYMCKO NYTHAKKO BO3MN0
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4 Crvka nyro-npyKsor npenaza
Bijeljina)

Slika 33. Vizuelni prikaz podataka o saobraéajnim
nesre¢ama na putno-pruznom prelazu u km
57+306 pruge 207
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Slika 34. Vizuelni prikaz podataka o saobracajnim
nesrecama na putno-pruznom prelazu u km
134+890 pruge 102
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Slika 35. Vizuelni prikaz podataka o saobraéajnim
nesrecama na putno-pruznom prelazu u km
17+352 pruge 106

6. ZAKLJUCAK

Geografskim informacionim sistemom QGIS pred-
stavljen je znacaj primene softvera u analizi put-
no-pruznih prelaza u Srbiji. Kroz detaljnu obradu
i vizualizaciju podataka, identifikovane su klju¢ne
tacke interakcije izmedu Zeleznickog i drumskog
saobracaja, kao i oblasti sa najve¢im rizikom od
nesreca. Implementacija QGIS-a omogucila je ne
samo efikasno mapiranje i analizu postojecih put-
no-pruznih prelaza, ve¢ i identifikaciju i potenci-
jalne predloge mera za unapredenje sigurnosti na
ovim Kkriti¢nim tackama.

Jedan od zaklju¢aka ovog istrazivanja je da su naj-
CeS¢i uzroci nesreéa na putno-pruznim prelazima
nepostovanje saobracajnih propisa od strane vozaca
i nepovoljni tehnicki uslovi infrastrukture. QGIS je
omogucio da se ovi problemi vizualizuju i analizira-
ju na sistematican nacin, sto je olaksalo identifikaciju
kriti¢nih ta¢aka i planiranje potrebnih intervencija.

Dalji razvoj i unapredenje QGIS softvera mogli
bi dodatno da povecaju njegovu upotrebljivost,
efikasnost i pouzdanostu ovakvim analizama. In-
tegracija sa drugim bazama podataka i alatima
za analizu saobracajnih nesre¢a moze pruZiti jos
bolje i detaljnijih uvida u stanje bezbednosti sao-
bracaja i dana taj nacin pomognu u formiranju sve-
obuhvatnijih strategija za unapredenje sigurnosti i
bezbednosti na putno-pruznim prelazima. Takode,
razvoj dodatnih funkcionalnih alata za simulaciju i
predikciju saobracajnih tokova moZe znacajno da
doprinese prevenciji nesreca i planiranju razvoja i
unapredenja saobracajne infrastrukture.

Vaznost koriS¢enja naprednih GIS alata u analizi
saobracajne infrastrukture, a narocito pruga pred-
stavlja znacajan faktor u istraZivanju, planiranju i
projektovanju na Zeleznici [11]. Samim razvojem
novih tehnologija, kao i njihovom prakticnom
primenom dolazi do potencijalnih unapredenja
i iznalazenja novih nacina za povecanje bezbed-
nosti i znafajno smanjenje rizika od nesreca na
putno-pruznim prelazima. QGIS se pokazao kao
veoma mocan alat koji predstavlja podrsku dono-
siocima odluka u funkciji poboljSanja efikasnosti
i bezbednosti saobracaja. na taj nacin direktnose
poboljsava ukupna saobracajna infrastruktura,
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a istovremeno smanjuju rizici od deSavanja sao-
brac¢ajnih nesre¢a na putno-pruznim prelazima,
ali isto tako i ukupno.
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